
 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 



 
 

SAŽETAK 

 

U radu je opisan razvoj fotografije i fotografskih sustava kroz povijest i osam 

različitih postupaka konverzije kolor fotografije u crno-bijelu. Zatim se, u 

eksperimentalnom dijelu šest originala u boji kovertira u crno-bijelu fotografiju. 

Cilj je ispitivanje utjecaja konverzije na tonove crno-bijele fotografije na tri 

načina, te, na posljetku, njihovo povezivanje. Ispitivanje se sastoji iz tri dijela. U 

prvom se dijelu analizira subjektivno mišljenje desetero ispitanika, zatim slijedi 

tehnička analiza autora fotografija, i, na kraju, izrada histograma pripadajućih 

konvertiranih fotografija. Pretpostavlja se da će se iz dobivenih rezultata moći 

ukazati na mogućnost odabira postupka konverzije ovisno o motivu fotografije. 

KLJUČNE RIJEČI: crno-bijela fotografija, tonovi, konverzija, histogram 

 

ABSTRACT 

 

This paper describes the development of photography and photographic 

systems during the history. It also describes eight different methods of colour 

photography conversion into black and white. These methods are described in 

experimental part. Six different colour photos are converted in black and white 

photos. The main objective of this work is to research the influence of different 

conversions into back and white, and their connection at the end. The research 

is divided into three parts. Ten different people were analysing the photos. Their 

subjective opinions are given in the first part of the research. In the second part 

authors technical analyse is given, and at the end of research converted 

photographs histograms are created. It assumes that from the results obtained, 

it will be possible to choose conversion method depending of photography 

motive. 

KEY WORDS: black and white photography, tones, conversion, histogram 
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1. UVOD 

 

Fotografija je svevremenski način zabilježavanja onoga što se u trenutku 

fotografiranja nalazilo ispred fotografskog aparata: osoba, događaj, predmet, 

pejsaž i slično. Fotografiranje je široko i zanimljivo područje grafike, a u isto 

vrijeme i umjetnosti iz razloga što na brz i točan način daje  mogućnost 

umnožavanja, te je moćno sredstvo izražavanja. Fotografija postoji već više od 

150 godina, te se nalazi u svim područjima ljudskog života, pogotovo u novije 

vrijeme. S obzirom na to da je napredak tehnologije omogućio svima 

zabilježavanje motiva, pejsaža, dragih osoba tj. stvaranje uspomena u bilo 

kojem trenutku, slobodno se može reći da je u današnje vrijeme fotografija jako 

važan segment svačijeg života i da bi u ovo moderno doba bilo poprilično teško 

živjeti bez nje. Fotografija je, zapravo, i komunikacijsko sredstvo koje daje 

ogromnu količinu informacija. Iz fotografije su se razvile kinematografija i 

televizija koje se temelje na fotografiji (svjetlosnom zapisu slike). Kroz povijest 

se fotografija dosta tehnički promijenila. Usporede li se materijali i fotografske 

tehnike koji su se koristili nekad, s onima koji se koriste danas, slobodno se 

može reći da neki nekadašnji materijali i tehnike danas imaju samo povijesno 

značenje. Fotografija se može podijeliti na crno-bijelu i kolor fotografiju. Za kolor 

fotografiju karakterističan je cijeli spektar boja, a za crno-bijelu fotografiju 

karakteristični su tonovi između crne i bijele boje, te se sve svodi na glavna 

svojstva svjetla (svjetlina i kontrast).  Kolor fotografija daje više informacija 

promatraču, ali je upravo zbog toga crno-bijela fotografija uvjerljivija i 

elegantnija te duže zadržava pažnju promatrača. Grafički crno-bijela fotografija 

djeluje snažnije ako je kontrast u njoj veći. Danas se crno-bijela fotografija može 

dobiti na razne načine, direktno ili konverzijom. U ovom radu istražit će se 

dobivanje crno-bijele fotografije konverzijom, te prednosti i nedostaci raznih 

postupaka konverzije kolor fotografije u crno-bijelu. [1,2] 
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2. TEORIJSKI DIO 

 

2.1. Razvoj klasične crno-bijele fotografije 

 

Čovjek je oduvijek promatrao i pokušavao zabilježiti stvari koje su ga 

opčinjavale, a to mu je omogućeno zahvaljujući procesu stvaranja slike pomoću 

svjetlosti tj. fotografiji. Riječ fotografija nastala je od grčkih riječi phos (svjetlost) i 

graphis (olovka,kist). Prevedemo li doslovno, fotografija bi značila crtanje 

pomoću svjetlosti. Stoga se početkom fotografije može smatrati tzv. camera 

obscura (lat. zamračena prostorija) (Slika 1). To je, zapravo, postupak kojim su 

umjetnici u 16. stoljeću projicirali željenu sliku na zid prostorije tako da su 

zamračili cijelu prostoriju, te je jedina svjetlost ulazila kroz malenu rupu na 

jednom zidu. Iako se naziv čini kamera, za naprave koje bilježe slike, 

besmislen, on dolazi od latinske riječi camera, što znači soba ili prostorija. 

Kamera opskura nema mogućnost trajnog bilježenja slike, ali princip rada 

današnjih kamera i fotoaparata zasniva se baš na ulasku svjetlosti u tamnu 

komoru kroz maleni otvor i bilježenju te svjetlosti.  
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Slika 1. Kamera opskura, izvor: https://en.wikipedia.org/wiki/Camera_obscura 

 

Efekt kamere opskure su koristili su mnogi, iako nisu bili toga svjesni. Čak je 

Aristotel u 4.st. pr. n. e. otkrio da se propuštanjem zrake svjetla kroz mali otvor 

u mračnu prostoriju i držanjem papira petnaestak centimetra od otvora, na 

papiru pojavljuje prizor izvan sobe. On je, zapravo, napravio prvu bilješku o 

tome. Neki su slikari, većina njih iz talijanske renesanse, htijeli što vjernije 

prenijeli obrise pejzaža ili portreta neke osobe, pa su na osnovi tih obrisa lakše 

dolazili do uvjerljivih slika. Svi su oni nastojali trajno zabilježiti sliku kamere 

opskure. Razvitak prijenosne kamere opskure je sljedeća stepenica prema 

modernom fotoaparatu, ali uvijek se javlja problem kako trajnije zabilježiti sliku. 

Provodili su se različiti ekperimenti kemijskim sredstvima osjetljivima na 

svjetlost, sve do 1825. godine kad je Nicéphore Niepce otkrio tehniku kojom se 

može trajnije zadržati sliku. Provodila se višesatna ekspozicija uz jako dnevno 

sunce. Nicéphoreu Niepceu je u njegovim eksperimentima pomagao pariški 

slikar Jacques Daguerre. Zajedno su pokušavali usavršiti tehniku zabilježavanja 

slike, te je Jacques Daguerre, nakon smrti Niepcea, sam nastavio s 

istraživanjima. 1839. god. Daguerre otkrio je kako sačuvati pozitiv slike. Taj je 

postupak nazvan dagerotipijom, a francuska je Vlada otkupila sva prava na 

https://en.wikipedia.org/wiki/Camera_obscura
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njegov izum (permanentni pozitiv) (Slika 2). Slobodno se može reći da je 

dagerotipija (franc. daguerréotypie), prvi praktički primjenljiv fotografski 

postupak za dobivanje trajne slike. Postupkom dagerotipije se srebrna ili 

posrebrena ploča izlagala jodnim parama, osvijetlila u kameri opskuri, a 

latentna slika, nastala u fotoosjetljivu sloju srebrnoga jodida, razvijala se u 

živinim parama. Trajnost slike postizala se  namakanjem ploče u otopini 

kuhinjske soli. Nedostatak postupka je nemogućnost umnožavanja, a na 

pozitivu su lijeva i desna strana međusobno zamijenjene.[3] 

 

 

Slika 2. Dagerotipija, izvor: www.fotografija.hr 

 

U istom je  periodu u Engleskoj William Fox Talbot razvio je osobit postupak 

fotografiranja pod nazivom kalotipija, poslije nazvan talbotipija, koji je omogućio 

umnožavanje fotografskih snimaka (Slika 3). Fox je eksponirao papir premazan 

srebrnim kloridom i kemijski razvijao taj negativ, te je svoj izum patentirao i na 

taj način ograničio razvoj i popularnost tog postupka. [3,4] 
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Slika 3. Kalotipija, izvor: 

http://www.astrokaktus.com/DigitalPhotography/Fotografija/zgodovina/z_zgodov

ina-fotografije_kalotipija.html 

 

Robert Bingham je prvi pokušao primjeniti kolodij kao fotografski sloj 1850.god. 

Izlio ga je na staklenu ploču i eksponirao ploču dok je još bila mokra. Mnogi 

portreti nastali su na taj način. Ambrotipijom se naziva postupak Scotta Archera, 

i to je, zapravo, negativ na mokroj kolodijskoj ploči čija je pozadina prekrivena 

tamnom tkaninom ili lakom jer se negativ ispred tamne pozadine pojavljuje kao 

pozitiv. Ferotipija je postupak gdje se umjesto stakla upotrebljavao tanki željezni 

li premazan crnim ili smeđim lakom. Ferotipiju je patentirao Hannibal L. Smith, i 

ubrzao nicanje portreta (Slika 4). Postupak je opstao do sredine 20. stoljeća. 

[2,3] 
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Slika 4.Ferotipija, izvor: 

http://www.astrokaktus.com/DigitalPhotography/Fotografija/zgodovina/z_zgodov

ina-fotografije_ferotipija.html 

Sljedeći revolucionarni događaj bio je otkriće Georgea Eastmana. On je umjesto 

papira i staklenih ploča, uveo fotografski film. Film se sastojao iz tanke prozirne 

celuloidne trake premazane fotoosjetljivim slojem što je u odnosu na dotadašnje 

staklene ploče bilo pravo olakšanje. Više nije trebalo vući sa sobom velike ploče 

za ekspoziciju, glomazne fotografske aparate i otrovne kemikalije. 1888. godine 

pojavio se na tržistu fotografski aparat Eastmanove tvrtke Kodak pod sloganom 

„Vi pritisnite gumb, mi radimo ostalo“ (Slika 5). S fotografskim aparatom dobivao 

se i film. Kad je film bio iskorišten, fotoaparat se slao natrag u tvornicu koja je 

razvijala slike. Fotoaparat je tvornica vraćala s novom rolom filma. Interesantno 

je to što ime tvrtke Kodak ne znači ništa konkretno, samo su tražili kratku riječ 

koju će ljudi širom svijeta moći lako i točno izgovarati.  
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Slika 5. Kodakov fotoaparat iz 1888.godine, izvor: 
https://sk.wikipedia.org/wiki/Eastman_Kodak 

Nakon Kodakovog izuma u fotografiji je došlo do još nekoliko poboljšanja što se 

tiče optike, a najveća je želja od samih početaka bila da se stvori kolor 

fotografija.[3] 

2.1.1.  Dobivanje crno-bijele fotografije negativ-pozitiv postupkom 

Zahvaljujući izumima i otkrićima navedenim u prethodnom poglavlju, te 

najvažnijem otkriću Williama Foxa Talbota koji je predstavio je svoj negativ-

pozitiv postupak, suvremeni negativ-pozitiv postupak kod klasične crno-bijele 

fotografije ne razlikuje se puno od onog iz 1839. godine. Današnji negativsko-

pozitivski postupak zasnovan je na osvjetljavanju (eksponiranju) sloja 

fotografske emulzije nanesene na fotografski film ili ploču. Fotoosjetljivi sloj je 

suspenzija vrlo sitnih kristalića srebrnih halogenida (uglavnom srebrnog 

bromida) u želatini, na čijim osvijetljenim mjestima dolazi do fotokemijske 

reakcije, tj. raspada (fotolize) srebrnih halogenida (redukcija srebrnih iona u 
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atome) i izlučivanja crnih zrnaca elementarnog srebra. Gustoća crnih zrnaca je 

veća sve što je intenzitet svjetla jači,ali slika koja nastaje je latentna. Da bi slika 

postala vidljiva, potrebna je naknadna kemijska obrada (razvijanje i fiksiranje). 

Razvijanjem se nastavljaju raspad i redukcija srebrnih halogenida, sve dok slika 

ne postane dovoljno zacrnjena. Proces razvijanja prekida se neutralizacijom i 

ispiranjem razvijača. Fiksiranjem (uklanjanjem neraspadnutoga srebrnog 

halogenida) uz pomoć natrijevog ili amonijevog tiosulfata osigurava se 

postojanost slike. Slika dobivena na taj način naziva se negativ, jer tamni 

(neprozirni) dijelovi odgovaraju svijetlim dijelovima fotografiranog predmeta i 

obrnuto. Pozitiv (realna slika) dobiva se kontaktnim kopiranjem ili projekcijskim 

povećavanjem negativa i kopiranjem na fotografski papir te ponovnim 

razvijanjem i fiksiranjem. 

Pozitiv se može dobiti i kao prozirna slika specijalnom obadom direktno na filmu 

tako da se osvijetljena zrnca kemijski uklanjaju,te se reeksponiranjem aktiviraju 

neosvijetljena zrnca srebrnih halogenida. [4] 

2.2. Razvoj klasične kolor fotografije 

Otkriće kolor fotografije dogodilo se nakon dugogodišnjih istraživanja i tisuća 

eksperimenata. Najznačajnije promjene u poimanju boje dogodile su se 

zahvaljujući Isaacu Newtonu koji je 1669. godine je dokazao da je sunčevo 

svijetlo mješavina spektralnih boja, a ne materijalne boje pigmenata i njihovih 

fizičkih svojstava, kako su do tada mislili umjetnici. Newton je uočio dugu i 

pretpostavio da se te boje mogu dobiti prolaskom bijele svijetlosti kroz prizmu. 

Tu pretpostavku dokazao je tako da je rasuo bijelo svijetlo na zid komore i 

sabrao ga opet natrag sabirnom lećom. Budući da je u to vrijeme taj dokaz nije 

bio prihvaćen, Newton je nailazio na brojne kritike od strane umjetnika koji su 

mu se poprilično protivili. Provodeći daljnja istraživanja, zaključio je da neki 

predmeti poprimaju svoju boju tako što neke boje apsorbiraju, a druge 

reflektiraju. No, i danas je to teško shvatiti miješanje svjetlosnih boja i 

pigmenata, a tad je bilo još teže. Lako je shvatljivo da su osnovne boje plava, 

zelena i crvena, i da njihovim aditivnim miješanjem u projekciji nastaje bijela 

svijetlost,ali je teže shvatljivo kako primjerice zelena i crvena daju žutu. Zna se 
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da su osnovne boje plava, zelena i crvena, i da njihovim aditivnim miješanjem u 

projekciji nastaje bijela svijetlost. Međutim malo je teže shvatljivo kako zelena i 

crvena daju žutu. Ove pretpostavke objašnjene su zahvaljujući prirodi ljudskog 

oka (osjetljivost pojedinih čunjića na mrežnici ljudskog oka djelomično se 

poklapa sa crvenim, zelenim i plavim dijelom vidljivog spektra). 1861. godine je 

Engleski fizičar James Clerk Maxwell pokazao kako se pomoću plave, zelene i 

crvene boje mogu projiciranjem dobiti sve ostale i za njega se, zapravo, vežu 

počeci kolor fotografije. Snimio je jednu vrpcu s tri različita aditivna staklena 

filtra od kroz koje je propuštao svijetlost i na taj način dobio negative. Zatim je iz 

negativa izradio pozitive te ih projicirao kroz ta tri filtera: crvena snimka sa 

crvenim filtrom, zelena sa zelenim filtrom i plava sa plavim filtrom. Postupkom 

točnog preklapanja svih triju slika dobivena je prva optička slika u boji, 

projekcijskim putem uz pomoć aditivnog načina miješanja boja. Pokus mu je 

uspio,ali je kvaliteta slike bila loša. Postavljalo se pitanje kako je mogao doći do 

zelene i crvene snimke, to jest do snimaka preko zelenog i crvenog filtra kad je 

ta vrste emulzije bila potpuno neosjetljiva na zeleno i crveno odnosno na zeleni 

i crveni dio bijelog svijetla. [5,6]  

Smatra se da je prvu kolor fotografiju izumio Louis Ducos Du Haurona 

1869.godine. On je prvi izradio kolor fotografiju na principu suptraktivnog 

miješanja boja (Slika 6). Pretpostavio je da pigmenti apsorbiraju odnosno 

oduzimaju od svijetlosti sve boje osim vlastite koju reflektiraju. Od Newtona je 

preuzeo teoriju o refleksiji i apsorpciji koji je davno prije došao do tog saznanja.  
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Slika 6. Prva kolor fotografija, izvor: http://www.cahayabox.net/2010/03/25/top-
25-najstarijih-povijesnih-fotografija/ 

 

Trikromija je najstariji poznati pigmentni postupak kojeg je osmislio Hauron. U 

početku je upotrebljavao kalotipiju (snimanje i presnimavanje na papiru) sve dok 

nisu 1871. godine počeli koristiti staklenu želatinsku ploču i senzibilizatore. Na 

sastanku fotografskoga društva u Parizu 7.svibnja 1869.godine iznio je svoje 

teoretske osnove vezane za kolor fotografiju te se taj događaj uzima kao 

nastanak kolor fotografije. Hauron se smatra izumiteljem kolor fotografije i zbog 

spoznaje da se pomoću tri boje, magenta, zelene i cijan mogu proizvesti sve 

boje ako su pomiješane određenim proporcijama. U samom početku imao je 

dosta problema jer u to vrijeme još nije bila poznata pankromatska emulzija. 

1880. godine je  pankromatska emulzija došla na tržište, te je s vremenom 

dolazio je do sjajnih izvedbi. Mnogi su pokušavali preuzeti njegove ideje, ali je 

on koristio suptraktivnu metodu na papiru i omogućio izradu slika teorijski i 

praktično. Hauron je papir od sloja želatine i čađe od svjetiljke izrađivao tako da 

ga je senzibilizirao kalijevim bikromatom i eksponirao na suncu, te prao u toploj 

vodi gdje bi na kraju dobio pozitiv sliku na papiru. Kada je umjesto čađe 

upotrijebio drugu boju pigmenta, dobio je monokromatsku sliku u jednoj boji. 

http://www.cahayabox.net/2010/03/25/top-25-najstarijih-povijesnih-fotografija/
http://www.cahayabox.net/2010/03/25/top-25-najstarijih-povijesnih-fotografija/
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Hauron je primijetio da su za trikromatsku sliku potrebne tri vrste pigmenata s tri 

vrste papira (žuta, ljubičasa, plava). Današnja se fotografija u boji temelji na 

principima prema kojima je radio Ducos Du Hauron. [5] 

Pankromatska ploča izumljena je 1906 .godine u tvornici Farbenindustrie.  

pojavila se pankromatska ploča od Farbenindustie.1891. godine Gabriel 

Lippman otkrio je da interferencija svjetla omogućuje proizvednju kolor 

fotografija na principu pojave svjetlosne interferencije tankih listića. Kako bi 

došlo do interferencije, fotografska ploča se s emulzijske strane presvukla sa 

srebrenim bromidom. Emulzijska se strana uz pomoć specijalne kazete stavlja u 

kontakt sa živom koja prouzrokuje pojavu interferencije. Zatim je slijedilo 

snimanje i dobivanje pozitivne slike,te promatranje te slike kroz odgovarajuće 

specijalne prizme i na taj su se način dobile lijepe interferencijske boje. [3,5] 

1908. godine Lipman je dobio Nobelovu nagradu za svoj aditivni postupak 

pomoću lasera na bazi sitnih leća. Ovdje su se interferencijske boje mogle 

koristiti kao filteri i oni su bili idealno čisti s točno određenim valnim duljinama. 

Danas se filteri izrađuju na drugim postupkom. Dan danas su principi isti kod 

preokretnih i kod negativ-pozitiv postupaka, što znači da su gotovo svi današnji 

troslojni kolor-materijali izrađeni po načelu suptraktivnog miješanja boja. U 

današnje vrijeme postoji nekoliko grupa materijala: negativ-pozitiv materijali s 

postupcima obrade negativa i pozitiva; invertibilni filmovi i papiri za izradu 

dijapozitiva i slika po invertibilnom procesu obrade; polakolormaterijali 

difuzijsko-prijenosnog procesa; materijali s nanesenim sintetskim bojama u 

slojevima u toku produkcije fotografskog materijala koji se razlikuju i po obradi; 

te troslojni materijali u boji s komponentama za boje i odvojenim stvarateljima 

boja. 

Razvojem fotografije u boji potreba za fotografskim aparatom postaje sve veća. 

Cilj je bio snimiti trostruke ekspozicije kroz tri različita filtera sa što većom 

brzinom i jednostavnošću. Prvi takav fotoaparat izumio je Ducos Du Hauron i 

nazvao ga „melanochromoscop“. Dijelovi melanochromoscop-a bili su: objektiv, 
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tri negativa jedan iza drugog, sistem unutarnjih leća, poluprozirna zrcala i filteri 

u boji. 

Još jedan izum važan za razvoj kolor fotografije je JOS-PE fotoaparat koji je 

omogućavao izradu „moment-snimaka“ na način da su sve tri ploče snimane 

istodobno (aparat je, osim kazete na optičkoj osi,imao još dvije kazete sa 

strane). JOS-PE aparat se brzo proširio iz Njemačke po cijelome svijetu. JOS-

PE fotoaparat sa tržišta su potisnuli novi izumi- Kodachrome filmovi iz 1935. 

godine i Agfacolor filmovi  iz 1936.godine. [1,5] 

2.2.1. Dobivanje klasične kolor fotografije negativ-pozitiv postupkom 

U osnovi je dobivanje klasične kolor fotografije negativ-pozitiv postupkom slično 

postupku dobivanja crno-bijele fotografije. Ducos Du Hauron uvelike je utjecao 

na razvoj kolor fotografije općenito, a posebno na negativ-pozitiv postupak 

dobivanja kolor fotografije, kao što je prethodno navedeno u radu.  

U današnje se vrijeme klasična fotografija u boji dobiva uz pomoć fotografskog 

materijala na kojem je emulzija građena troslojno: jedan je sloj osjetljiv na plavi 

dio spektra, drugi na zeleni, a treći na crveni. Negativsko-pozitivskim 

postupkom, nakon kemijske obrabe filma, dobiva se prozirni negativ u 

komplementarnim bojama, tj. plava boja reproducirana je žuto, zelena purpurno, 

a crvena modrozeleno. Projiciranjem negativa na fotografski papir kroz sustav 

filtara, na temelju suptraktivne sinteze boja, dobiva se pozitiv s realnim zapisom 

boja. Tijekom izrade fotografija u boji nije moguće kreativno intervenirati (za 

razliku od crno-bijeloga negativsko-pozitivskog postupka) pa se one najčešće 

izrađuju automatski. 

2.3. Razvoj digitalne fotografije 

 

Postoje mišljenja kako povijest digitalnih fotoaparata počinje nedavno, ali razvoj 

digitalne fotografije seže malo dublje u povijest. Tradicionalna je fotografija 

sputavala fotografe koji su radili na terenu (naročito novinarske dopisnike) iz 

razloga što nisu imali laboratorij za razvijanje filma u blizini. Za vrijeme hladnog 
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rata između Rusije i SAD, slanjem prvih satelita i potrebom da se 

špijunira protivnik, nastala je potreba za korištenjem fotoaparata bez filma. [6] 

Međutim, povijest digitalne fotografije počinje još ranije. Još davne 1908. godine 

škotski je zanesenjak i znanstvenik Alan Campbell Swinton prenio u lokalnom 

znanstvenom časopisu svoju ideju o snimanju i projekciji slike na daljinu, 

spajanjem dva uređaja elektronskim putem. Ispred svog vremena, Campbell je 

u svoj uređaj uključio i mehaničke i optičke dijelove.  

Od 1910. do 1915. godine Marconi, De La Forest i ponajviše Edwin Armstrong, 

smislili su niz izuma po pitanju prijenosa radiovalova i frekvencijske modulacije 

radiovalova. Zahvaljujući njima, danas postoje  radio televizijski programi i 

ostala bežična komunikacija. Za dvadesete godine 19. stoljeća karakteristično 

je osmišljavanje dijelova potrebnih za projiciranje slike. Takvi su dijelovi danas, 

na neki način, u tragovima prisutni u digitalnim fotoaparatima i 

videokamerama. 1923. godine je Vladimir Zvorkin izumio televizijsku slikovnu 

cijev, a kasnije i uređaj pod nazivom Iconoscope (kamera i televizijski uređaj 

koji obrađenu sliku dijele na tisuće dijelova, budućih piksela) (Slika 7). [7] 

 

 

Slika 7. Iconoscope (Vladimir Zvorkin), izvor: en.wikipedia.org 

 

1924. godine je po prvi put fotografija poslana preko Atlanskog oceana. To se 

dogodilo zahvaljujući američkoj kompaniji RCA (Radio Corporation of America) , 

a fotografija je poslana uz pomoć preteče današnjeg telefaks uređaja. 
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Zanimljivo je to što je iste godine predstavljen i prvi maleni 35-milimetarski 

fotoaparat Leica (Slika 8).  

 

 

Slika 8. Leica, izvor: hr.wikipedia.org 

 

1927. godine dogodio se prvi javni televizijski prijenos. Kako je televizija sve 

više napredovala i pružala sve veću konkurenciju, fotografije su se sve brže 

morale dostavljati u novine. Fotoreporteri na udaljenijim lokacijama nosili su 

minijaturni foto-laboratorij sa sobom, također i neka sredstva prenošenja slike 

preko telefonskih žica. 

Prvi CCD senzor predstavili su Willard Boyle i George Smith (Bell Labs) 1969. 

godine. CCD (Charged Coupled Device) senzor je senzor s nizom električnih 

fotoosjetljivih jedinica, spojenih u redove, koji je mogao zabilježiti sliku i prenijeti 

je do procesora za obradu slike. Konkretnije informacije i detalji vezani uz CCD i 

CMOS senzore obrađeni su u poglavlju 2.4. 

Prvi pokušaj razvijanja digitalnog fotografskog aparata koji koristi CCD senzor 

karakterističan je za Stevena Sassona iz tvrtke Kodak. Težina takvog 

fotografskog aparata iznosila je 3.6 kg, snimao je crno bijele slike na CCD 

senzor te je imao rezoluciju od 0.1 megapiksela. Da bi se snimila fotografija 

trebalo je otprilike 23 sekunde. Taj prototip fotografskog aparata je predstavljao 

eksperiment, koji nikada nije bio namijenjen produkciji. 

Prvu elektronički fotografski aparat sa CCD senzorom izumio je Sony Mavica 

1981. godine (Slika 9). To je, zapravo, bio analogni fotografski aparat koji je 
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snimao piksele na floppy disketu. Kapacitet diskete bio je manji od 1MB i na nju 

je stalo oko 25 fotografija.  

 

 

Slika 9. Sony Mavica, izvor:  www.digicamhistory.com/1980_1983.html 

Sljedeće važno otkriće dogodilo se 1987. godine. Znanstvenici iz tvrtke Kodak 

izumili su prvi megapiksel senzor koji je mogao zabilježiti 1.4 milijuna piksela. 

Prva prava digitalni fotoaparat bio je Fuji DS-1P iz 1988. godine. 1990. godine 

tvrtka Kodak upoznala je javnost s prvim komercijalnim dostupnim digitalnim 

fotografskim aparatom pod nazivom DCS 100 (Slika 10). Većini je bio 

nedostupan zbog visoke cijene, upotrebljavala se samo u novinarstvu i 

profesionalno. Ipak se taj događaj obilježava kao rođenje komercijalne digitalne 

fotografije. [6,7] 

https://hr.wikipedia.org/w/index.php?title=Kodak&action=edit&redlink=1
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Slika 10. Kodak DCS 100, izvor: en.wikipedia.org/wiki/Kodak_DCS_100 

Do 2000. godine koristili su se većinom CCD senzori  za digitalnu obradu 

fotografija prvenstveno u industrijskom okružju, ali nakon toga počinju 

prevladavati CMOS senzori. [8] 

 

2.4. Formiranje slike u digitalnom fotoaparatu 

 

Slika u digitalnom fotografskom aparatu nastaje na sličan način kao u klasičnom 

fotografskom aparatu što znači da objektiv fokusira sliku, a otvor blende i brzina 

zatvarača određuju pravilnu ekspoziciju. Razlika je u tome što se mogu birati 

raznovrsni načini snimanja. Još jedna bitna razlika je ta što kroz objektiv ne 

pada na film već na čip koji je osjetljiv na svjetlo (senzor) koji je spomenut u 

prethodnog poglavlju, te će u ovom poglavlju biti pomnije obrađen. Kada se 

nešto fotografira, slika se upisuje u memorijsku jedinicu koja je neka vrsta diska 

ili magnetske kartice. CCD senzor je mali silikonski čip koji sadrži na tisuće ili 

milijune, na svjetlo osjetljivih, elemenata (piksela). Svjetlo koje pada na piksel 

izaziva stvaranje električnog napona, koji se pretvara u niz digitalnih podataka 

koje može pročitati računalo. Što više piksela sadrži CCD senzor, bolja je 

kvaliteta tj. rezolucija slike. Danas se u digitalnim fotoaparatima najčešće koristi 
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filtarska mreža u kojoj su polja posložena po Bayerovom uzorku. Bayerov 

uzorak čini 50% zelenih polja, te po 25% plavih i crvenih polja. Zelena su polja 

mnogo više zastupljenija zbog najveće osjetljivosti ljudskog oka na upravo tu 

boju. Postoji više varijacija Bayerovog uzorka, gdje se koriste četiri boje, cijan 

umjesto polovica zelenih polja, ili uzorak s četiri boje: cijanom, magentom, 

žutom i zelenom. Ipak, takve su izvedbe mnogo manje zastupljene. Dodatni 

zeleni filtar prisutan je zato što je ljudsko oko najosjetljivije na zelenu svjetlost. 

U ovoj fazi električni signali svake ćelije razmjerni su jačini upadne svjetlosti. 

Kako bi se informacija pretvorila u digitalni oblik, signal se mora digitalizirati, 

odnosno kvantizirati što znači da se svakom signalu dodjeljuje određeni broj. 

Nakon toga informacija se vrlo lako može obraditi računalom. Digitalni 

fotografski aparat obrađuje različite jakosti signala iz pojedinačnih ćelija tako da 

svaki piksel slike dobije odgovarajuću vrijednost boje: za svaki se piksel na 

temelju podataka iz susjednih ćelija izračuna ili unese njegova vrijednost. Ta 

interpolacija boje ključni je korak jer omogućuje proračun o kojem ovisi konačna 

kakvoća snimljene fotografije. Poboljšanje kakvoće digitalne fotografije uz 

poboljšanja fotoosjetljivih senzora zasluga su usavršavanja interpolacijskih 

algoritama. Vrijednosti se za svaki piksel skupljaju i povezuju pa tako nastaje 

slikovna datoteka, a u tom se procesu određuje i format, odnosno ustroj 

datoteke. Nakon obrade, digitalna se fotografija pohranjuje na disk ili u 

memoriju (Slika 11). Prvi dio procesa, bilježenje slike senzorima, obično je vrlo 

brzo, ali obrada i pohrana traju nešto dulje. Kako bi se ubrzao taj dio procesa, 

mnogi kvalitetniji fotoaparati imaju mnogo RAM-a, memorije za privremenu 

pohranu fotografija kako obrada snimaka ne bi ometala snimanje. 

Digitalni fotoaparati imaju opcije uz pomoć kojih se može birati kvaliteta snimke, 

tj. može se izabrati opcija upisa podataka bez kompresije, gdje će kvaliteta slike 

biti na zavidnoj razini, te opcija gdje se slika komprimira, gdje će kvaliteta slike 

biti manja, ali će zauzimati četvrtinu ili manje prostora u memoriji od 

nekomprimirane. Fotoosjetljivi element (senzor) u digitalnom se fotoaparatu 

nalazi na istom mjestu gdje se kod klasičnih fotoaparata nalazi film (u žarišnoj 

ravnini objektiva). Fotosenzor je zapravo bolji od filma jer je potpuno ravan i kod 

svake se ekspozicije nalazi na istom mjestu, što kod filma ne mora biti slučaj. 
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Digitalni i klasični fotoaparat rade na istom načelu što znači da oba svjetlosnu 

energiju rabe za promjenu stanja fotoosjetljive tvari. Ta se promjena potom 

električnim putem pojačava ili naglašava kako bi na posljetku fotoosjetljive tvari 

postale vidljive. Osnovna razlika između klasičnog i digitalnog fotoaparata je u 

tome što u digitalnom fotoaparatu svjetlost apsorbira fotoosjetljivi senzor, dok 

kod klasičnog fotoaparata svjetlost pada na fotoosjetljivi sloj filma. U digitalnom 

se fotoaparatu sve faze nastanka fotografije odvijaju u njemu: snimanje, obrada 

i pohrana. [8] 

Slika 11. Formiranje slike u digitalnom fotoaparatu, izvor: 

http://peytonbarbara.wix.com/otr-senzori#!senzori-u-fotoaparatima/c5ft 

U današnje se vrijeme na tržištu mogu naći različiti senzori koji se međusobno 

razlikuju po nekim karakteristikama. Tako primjerice postoje senzori koji se 

razlikuju u formatu slike (4:3, 16:9, 3:2, itd.), broju piksela, dimenziji slike i 

slično. Princip rada svih senzora u osnovi je jednak, ali bez obzira na to, mogu 

se podijeliti ih na tri osnovne vrste: CCD, CMOS i Foveon X3 senzore. 

CCD senzor (Charged Coupled Device) je uređaj koji se izađuje se od 

posebnog silicijskog čipa čija je jedna strana osjetljiva na svjetlo,a sastoji se od 

nekoliko tisuća fotoosjetljivih dioda (Slika 12). 

 

http://peytonbarbara.wix.com/otr-senzori#!senzori-u-fotoaparatima/c5ft
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Slika 12. CCD senzor, izvor: http://peytonbarbara.wix.com/otr-senzori#!senzori-u-

fotoaparatima/c5ft 

 

Diode bilježe jakost svjetla koje prime, te je pretvaraju u električni naboj. Jakost 

naboja i jakost svjetla koje ta dioda primi su proporcionalne. Na posljetku se 

očitani naboj pretvara u piksel, kao što je prethodno spomenuto u radu. 

Međutim, CCD senzor ne bilježi boje, nego samo jakost svjetla koje pada na 

njega. Tako nastala slika šalje se u određene filtere za boju, koji zatim bilježe 

crvenu, zelenu ili plavu boju (RGB). Moguće je upotrijebiti i više CCD senzora, 

od kojih svaki bilježi jedan spektar boja. U tom slučaju se koristi prizma koja 

rastavlja svjetlost na crvenu, zelenu i plavu, te svaku određenu boju šalje 

odgovarajućem CCD senzoru. Na taj se način individualno bilježi jakost svjetla 

za svaku boju. CCD u doslovnom prijevodu znači uređaj povezan nabojem. To 

je pravokutna matrica u vidu mozaika, sastavljena od milijuna kvadratnih ili 

pravokutnih ćelija. Od dimenzije površine čipa ovisi i broj fotoosjetljivih ćelija. 

Očitavanje električnih impulsa iz ćelije se izvodi serijski, odnosno jedan za 

drugim. Električne impulse treba pojačati, te se kod CCD senzora pojačivači 

nalaze na kraju svakog reda. [9] 

CMOS senzori (Complementary metal–oxide–semiconductor sensor) nazvani 

su prema tehnologiji na čijem principu rade. CMOS tehnologiju je 1967. godine 

patentirao Frank Wanlass. 

 

http://peytonbarbara.wix.com/otr-senzori#!senzori-u-fotoaparatima/c5ft
http://peytonbarbara.wix.com/otr-senzori#!senzori-u-fotoaparatima/c5ft
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Slika 13. CMOS senzor, izvor: http://peytonbarbara.wix.com/otr-senzori#!senzori-u-

fotoaparatima/c5ft 

CMOS senzor, isto kao i CCD senzor radi na principu mreže milijuna sitnih 

fotoosjetljivih ćelija (Slika 13). Svaka od tih ćelija stvara električni impuls kada 

na nju padne svjetlo, a snaga impulsa ovisi o količini svjetla. Bitna razlika 

između CMOS i CCD senzora je u načinu na koji se taj električni impulsi iz ćelija 

prikupljaju. Kod CCD senzora očitavaju se serijski, jedan za drugim. Kod CMOS 

senzora govorimo o X-Y adresiranju. Naime, kod CMOS senzora svaka se 

fotoosjetljiva ćelija može zasebno očitati, pomoću adresiranja po koordinatnoj 

mreži. Na taj je način sve električne impulse moguće odjednom procesirati, 

oslobađajući senzor za sljedeću ekspoziciju. Takav način rada senzora 

omogućuje i mjerenje ekspozicije, te autofokusiranje. Jedan od glavnih 

nedostataka CMOS senzora je šum, a on se posebice pojavljuje kod većih ISO 

vrijednosti. [16]  

Foveon X3 senzor je posebna vrsta CMOS senzora koja je ušla u upotrebu 

2002. godine, a prvi fotografski aparat koji je koristio ovakav senzor je Sigma 

SD9 (Slika 14).  

http://peytonbarbara.wix.com/otr-senzori#!senzori-u-fotoaparatima/c5ft
http://peytonbarbara.wix.com/otr-senzori#!senzori-u-fotoaparatima/c5ft
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Slika 14. Prednja i stražnja strana Sigme SD9, izvor: 

https://en.wikipedia.org/wiki/Sigma_SD9 

Ono što ga razlikuje od ostalih senzora je način zapisivanja boje na slici, tj. 

crveni, zeleni i plavi filtar se ne nalaze u istom rasporedu kao kod drugih 

senzora. Kod CCD i drugih CMOS senzora iznad svakog polja senzora nalaz se 

po jedan filter koji registrira samo jednu boju i, da bi se dobila višebojna slika, 

potrebno je tri jednobojna zapisa spojiti u jedan. Međutim, kod Foveon X3 

senzora crveni, zeleni i plavi filter se nalaze iznad cijele površine senzora. Na 

taj način svaki filter pokriva cijelu površinu senzora i u isto vrijeme zapisuje 

informacije o sve tri boje. Prilikom pada bijele svjetlosti na filtere prvi filter, plavi, 

registrira samo plavi dio svjetlosti, a propušta zeleni i crveni. Nakon toga zeleni 

filter registrira zeleni dio svjetlosti i propušta crveni dio svjetlosti do crvenog 

filtera. [17] 

S obzirom da nije potrebno spajati tri jednobojne slike u jednu RGB sliku, ne 

dolazi do nekih grešaka koje se javljaju kod senzora koji koriste Bayerov filter. 

Budući da kod Foveon X3 senzora nema potrebe za spajanjem jednobojnih R, 

G i B slika u jedinstvenu sliku u boji, nisu vidljivi ni pojedinačni pikseli na 

rubovima gdje se te boje preklapaju. 

Slike snimljene na ovaj način imaju vrlo mali udio šuma prilikom snimanja u 

RAW formatu, no neka su istraživanja potvrdila da unatoč svemu tome slike 

snimljene Foveon X3 senzorima i dalje imaju veću količinu šuma nego one 

snimljene senzorima s Bayerovim filterom. 
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Međutim, ta istraživanja ne treba doslovno uzimati kao činjenicu, jer još nije 

sigurno je li ta veća količina šuma posljedica samog filtera ili algoritama za 

procesiranje. [9] 

 

2.5. Formati zapisa digitalne fotografije 

 

Digitalne fotografije mogu se pohraniti pomoću više od 20 različitih formata.  

Formati datoteka predstavljaju različite načine pohranjivanja datoteka na disk. 

Neki formati omogućavaju jedinstvene načine kompresije, koji pohranjuju 

fotografiju tako da zauzima manje memorije u računalu. Drugi formati 

omogućavaju Photoshopu da razmjenjuje fotografije sa drugim aplikacijama na 

računalu. Za neke formate zapisa karakteristični su gubici, dok su drugi sirovi, 

kao što je RAW format. To je sirovi format bez kompresije podataka koji 

omogućuje maksimalnu kvalitetu zapisa fotografije, ali zauzima veliko količinu 

memorijskog prostora. Zapis fotografije se prvo učitava u odgovarajući program 

za predobradu u kojem se definiraju parametri fotografije (tj. prihvaćaju se oni 

postavljeni pri snimanju ili se mijenjaju) prvenstveno vezani uz tonove, boje i 

oštrinu te se, zatim, tako predobrađena fotografija sprema u nekom od 

standardnih formata.  

Neki od standardnih formata koji se u današnje vrijeme koriste su: .PSD, .TIFF, 

.BMP, .EPS, .PNG, .GIF itd.  Photoshop (PSD) je originalni format koji je 

optimiziran za Photoshopove mogućnosti i funkcije. Prvenstveno je bitan zato 

što podržava rad u layerima koje ne podržavaju drugi formati. TIFF (Tagged 

Image File Format) je najrašireniji format koji podržava ispis fotografija za sve 

računalne platforme i ujedno je najkvalitetniji format za pohranjivanje fotografija. 

On predstavlja jedini nezavisni format datoteke (pored PNG formata) koji može 

sačuvati informacije o rezoluciji. TIFF format može sadržavati i alfa kanale, a 

oni se ponašaju kao maske, odvajajući sliku prednjeg plana od pozadine i 

jednako tako daje mogućnost rada u layerima. Format podržava do 24 kanala, 

što je maksimalni broj kanala dozvoljen bilo kojoj slici u Photoshopu. Format 

podržava LZW kompresiju pri kojoj ne dolazi do gubitka podataka na fotografiji. 

BMP (Windows Bitmap) je originalan format Microsoft Painta i podržavaju ga 
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mnoge Windows, DOS i OS/2 aplikacije. Photoshop podržava BMP s najviše 16 

milijuna boja. EPS (Encapsulated Post Script) Photoshop podržava objektno 

orijentirane datoteke snimljene u EPS formatu. EPS je kreiran upravo za 

snimanje grafika orijentiranih na objekte koji se ispisuju pomoću Post Script 

izlaznih uređaja. Svi programi za vektorsku grafiku i većina programa za 

prijelom stranica dozvoljavaju spremanje EPS datoteka. EPS se sastoji od 

čistog Post Script opisa grafike za pisač i pregleda u bitmapi koji omogućava 

gledanje grafike na zaslonu.  

JPEG (Joint Photographic Experts Group) je najkorisniji format koji se najčešće 

upotrebljava kada je fotografiju potrebno pohraniti s kompresijom. JPEG 

prilikom komprimiranja zanemaruje dio podataka sa fotografije, a nivo 

kompresije je moguće izabrati. Danas je JPEG, s fotografskog stanovišta, 

standardni način spremanja fotografija uz kompresiju, te će kao takav biti 

osnovni upotrijebljeni format u eksperimentalnom dijelu rada.   

Vrlo je karakterističan jer, iako ima gubitaka prilikom kompresije, on u sebi 

ostavlja mogućnost upotrebe u gotovo svim sustavima boja (obitelj RGB 

sustava boja, CIEL*a*b*, CIELuv, HSV, CMYK sustavi boja), a obzirom da ima 

mogućnost ugradbe ICC profila postao je često korišten upravo za realizaciju i 

reprodukciju u tiskanim medijima. Po pitanju reprodukcije boja može se govoriti 

o dubini bita svakog pojedinog piksela koji se formira prilikom stvaranja JPEG 

datoteke. JPEG osim akromatskih odnosno monokromatskih slika dopušta 

pohranu do dubine od 24-bita čime je omogućeno da reproducira 16 milijuna 

boja, no svakom dodatnom kompresijom i dekompresijom dolazi do nekih 

promjena u strukturi zapisa i time do pada kvalitete slike. Dakako, postoje načini 

da se taj gubitak kompenzira, no oni se u pravilu svode na različite oblike 

interpolacije izgubljenih piksela (ukoliko je riječ o smanjenju broja piksela kao 

metodi smanjenja fotografije) no time se ne vraćaju prethodno izgubljeni podaci 

nego stvaraju novi na temelju okolnih piksela. Važna mana JPEG formata je 

veličini njegova zapisa, iz razloga što se kompresijom izravno utječe na njegovu 

kvalitetu i na taj način gubi na oštrini zapisa fotografije. [10] 
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2.6. Fotografija u RGB prostoru boja 

 

Prostori boja su trodimenzionalni modeli, pomoću kojih se određuju i 

vizualiziraju sve vidljive boje, te se definira koje se boje mogu koristiti u 

određenom reprodukcijskom sistemu. Postoji velik broj prostora boja, ali se u 

osnovi mogu podijeliti na boje bazirane na RBG-u i CMY-u. Za snimanje i 

prikazivanje slika karakterističan je RGB prostor boja. RGB prostorima boja 

definiraju se svi oni prostori koji u osnovi imaju RGB model aditivne sinteze boja 

iz crvene, zelene i plave. 

Koncept upravljanja bojama podrazumijeva primjenu načina rada koji teži 

standardizaciji prikaza digitalnih slika. Cilj je osigurati da izgled svake slike 

(boja, svjetlina i sl.) ostane konzistentan pri prebacivanju, pregledavanju i ispisu 

na svim računalima. ICC (Međunarodni konzorcij za boje) uspostavio je 

standard za definiciju sustava upravljanja bojama pri obradi i reprodukciji slike. 

Postoje dva RGB prostora boja: sRGB i Adobe RGB. Hewlett - Packard, 

Microsoft i ostali razvili su 1996. godine sRGB standardni prostor boja zaslona 

koji pomaže optimiziranju potreba u korištenju većine krajnjih korisnika. SRGB 

je kalibrirani RGB koji služi za definiranje boja na monitorima, televiziji i u 

printerima. SRGB prostor boja se najčešće upotrebljava za slike namijenjene 

ispisivanju bez daljnjih izmjena, te se i danas koristi u programima za obradu 

fotografija i uređajima za njihovu realizaciju. 

Adobe RGB je prostor boje u RGB modu kojeg je razvio Adobe Systems 1998. 

godine predstavljajući ga kao profil boje u Adobe Photoshop 5.0 aplikaciji koji je 

od tada u širokoj upotrebi implementiran u pripremi za tisak ili ispis u 

profesionalnom radnom toku. Napravljen je kako bi obuhvatio većinu boja koje 

može reproducirati CMYK pisač koristeći se pritom primarnim bojama aditivnog 

sustava (crvenom, zelenom i plavom) kakvim se koriste kompjuterski monitori. 

Sustav Adobe RGB može izraziti širi raspon boja od sustava sRGB pa je 

omiljen izbor za slike koje će se znatno obrađivati ili retuširati. Ono što je 

karakteristično za sve fotografske aparate je to da je sRGB uvijek zadana 

postavka.   
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AdobeRGB prostor boja koristi se u digitalnim fotografskim aparatima i s 

gamutom širim od onog sRGB-a pokriva oko 50% prostora boja koji je danas 

pokriven CIELab sustavom. [10,11]  

Uz pomoć RGB prostora boja moguća je pretvorba kolor fotografije u crno-bijelu 

konverzijom, što je, zapravo, tema ovog rada.  

 

2.7. Konverzija kolor fotografije u crno-bijelu 

 

Prilikom obrade kolor fotografije, digitalni fotoaparat ili softver za obradu 

fotografije, oslanja se na ugrađenu konverzijsku tablicu. Profesionalni softveri 

prilagođeni su tisku, te pretvorbu kolor fotografije u crno-bijelu rade prema 

svojstvima određenog tiskarskog stroja i papira. Na tržištu postoji i popriličan 

broj jednostavnih programa koji na vrlo brz način pretvaraju boju u sive 

vrijednosti, ali su takve fotografije u većini slučajeva jednolične. [12] 

 

2.7.1. Konverzija uz pomoć Photoshopa 

 

Photoshop omogućava dobivanje crno-bijele fotografije pomoću jednostavne 

opcije Grayscale (skala sivih tonova). Aktivira se preko izbornika Image > Mode 

> Grayscale i trenutno se slika u boji pretvori u crno-bijelu fotografiju (Slika 15). 
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Slika 15. Grayscale opcija 

 

Zasićenost boje na slici se smanjuje, a ukupna vrijednost svjetline ostaje 

nepromijenjena. Također se smanjuje veličina dokumenta za trećinu jer se 

isključuju crveni, zeleni i plavi kanal. Mana ove naredbe je u tome što se gubi 

RGB, te time spriječava naknadnu mogućnost korištenja filtera i efekta u 

Photoshop programu. Dobivena crno-bijela fotografija ne sadržava jaku crnu ili 

svijetlu bijelu boju. Ova metoda ne daje najbolje rezultate, ali je najjednostavnija 

od svih metoda. [13] 

Ako je cilj zadržati RBG kanale, umjesto Grayscale metode koristi se 

Desaturation metoda. Aktivira se preko naredbe Image > Adjustments > 

Hue/saturation (Slika 16). Pojavi se opcija gdje se može mijenjati Hue, 

Saturation i Lightness. Koristi se samo Saturation (zasićenost) opcija, te se 

‘’klizač’’ odvlači do minimuma zasićenja (-100) (Slika 17). Na taj način se dobiva 

snimka u sivim tonovima, ali sa svim podacima o boji. 
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Slika 16. Hue/saturation opcija, izvor: 

http://www.photoshopessentials.com/photo-editing/black-and-white/desaturate/ 

 

 

Slika 17. Odzasićivanje, izvor: http://www.photoshopessentials.com/photo-

editing/black-and-white/desaturate 

 

Osim Grayscale i Desaturation metode, Photoshop daje još jednu malo 

kompliciraniju metodu, a to je Black and White metoda (Slika 18). Do te opcije 

dolazi se preko Image > Adjustments > Black&White. Ova je metoda specifična 

jer nudi mogućnost manipulacije dobivanja crno-bijele fotografije detaljnim 

propuštanjem udjela RGB i CMYK spektra kroz nijanse sive. Kako bi povećali 

kontrast, potrebno je ‘’poigrati se’’ s udjelom RGB i CMYK spektra boja. 
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Pravilnim omjerom spektra, može se dobiti relativno kvalitetna crno-bijela 

fotografija. Ova metoda je slična metodi Channel mixer.  

 

Slika 18. Black and White opcija 

Photoshop nudi i opciju Channel mixing kojom se također fotografija u boji 

može pretvoriti u crno-bijelu fotografiju. Metoda je nešto kompliciranija, no daje 

najbolje rezultate. Korištenjem Channel mixing metode mogu se učinkovitije 

razdvajati tonovi sive boje tako da se svaka od RGB ili CMYK boja regulira 

posebno. Na taj način može se podesiti da se određenoj boji, koja je u kolor 

fotografiji izrazito naglašena, smanji njezin intenzitet u tonovima sive boje. Taj 

intenzitet amješta se pod opcijom Image > Adjustments > Channel Mixer. Otvori 

se prozor na kojemu su ponuđene RGB ili CMYK boje, ovisno u kojem sustavu 

boja je namještena sama fotografija. Označi se opcija Monochrome (Slika 19), 

te se klizačem podešavaju kanali boja. Može se mijenjati i konstanta, odnosno 

postojanost ukupnih tonova sive boje na fotografiji. Ponuđeni su i gotovi miksevi 

kanala gdje je pojačana samo jedna boja do maksimuma (Black&White 

Infrared, Black&White with Blue Filter, Black&White with Green Filter, 

Black&White with Orange Filter, Black&White with Red Filter, Black&White with 

Yellow Filter). 
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Slika 19. Channel mixer 

 

Lab boje su bliže ljudskom oku nego RGB i CMYK, te se, pretvaranjem kolor 

fotografija u crno-bijele fotografije pomoću te metode, dobivaju dobre fotografije 

koje najčešće nije potrebno naknadno dorađivati. Na tom principu pretvaranja L 

kanal (Lightness) bilježi informacije o svjetlini koje sadrže glavne informacije o 

tonovima na fotografiji. Takva konverzija postiže se klikom na Image > Mode > 

Lab Color (Slika 20). Nakon toga potrebno je označiti Window > Channels, te 

selektirati samo Lightness kanal. Tada se fotografija pretvara u 

monokromatsku. Ukoliko nismo zadovoljni rezultatom, fotografija se može 

dodatno obrađivati funkcijama Levels i Curves. Nakon toga potrebno je na 

označenom Lightness kanalu, selektirati Image > Mode > Grayscale gdje se 

ostali slojevi (layers) odbacuju i fotografija pretvara u skalu sivih tonova.  
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Slika 20. Lab Color 

Često se događa to da crno-bijela fotografija nastala konverzijom nije toliko 

atraktivna, bez obzira što sadrži velik raspon sivih tonova, jer daje dosta plošnu 

sliku bez velikog kontrasta. Silver look metodom može se postići to da se 

najsvjetliji dijelovi fotografije prikažu stvarno bijelima, a najtamniji stvarno 

crnima. U Photoshopu se to može postići tako da se fotografija u boji pretvori u 

monokromatsku (npr. Black & White metodom), te se označi Layer > New 

Adjustment Layer > Levels (tom opcijom možemo mijenjati razine crne, sive i 

bijele boje). Adjustment layer Levels aktivno djeluje na sve slojeve ispod sebe, 

te dolazi s bijelom maskom (Layer Mask) koja djeluje na cijelo područje. 

Područja u maski koja su bijela su aktivna, a područja koja su crna su 

neaktivna, te se brush alatom selektivno određuje na koje dijelove područja se 

želi utjecati opcijom Levels. Dakle, sa Levels layerom namješta se potamnjenje 

ili posvjetljenje fotografije, a djelovanjem brusha na masku određujemo koja 

područja zahvaća Levels. U slučaju da se želi posvjetliti dio fotografije, u Levels 

layer postave se parametri za posvjetljivanje, a sa brush alatom zacrnjuje se dio 

u maski koji se ne želi posvjetliti. Isto tako vrijedi i za potamnjivanje fotografije. 

U Levels layer postave se parametri za potamnjivanje, te se površina maske 

oboja u crno pomoću Paint Bucket alata. Zatim se bijelim brushem izvlače 

dijelovi koji će biti potamnjeni. Da bi se dobio potpuni Silver look efekt potrebno 
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je napraviti više zasebnih Levels layer-a za posvjetljivanje i potamnjivanje, od 

kojih svaki Levels layer ima različito postavljene parametre (Input i Output 

Levels) da bi se selektivno moglo utjecati na pojedine dijelove fotografije. [13] 

2.7.2. Konverzija uz pomoć online i offline aplikacija 

 

U današnje vrijeme suvremena tehnologija nudi razne načine konverzije kolor 

fotografije u crno-bijelu. Najbolji se rezultati dobivaju uz pomoć softvera, 

pogotovo ako je fotografija snimana u RAW formatu. Međutim, za amatere 

postoje različiti online sustavi i mobilne aplikacije koji mogu dati sličan, ako ne i 

približno isti rezutat. 

Jedan od online sustava za konverziju kolor fotografije pohranjene u JPEG 

formatu u crno-bijelu je LunaPic. To je, zapravo, popularna web stranica za 

obradu fotografija. Prvi korak je klik na Upload. Nakon što se fotografija učita, 

odabere se željeni efekt, a u ovom slučaju je to Black and White (Slika 21). 

Zatim slijedi klik na Save to my computer kako bi crno-bijela slika bila 

pohranjena.  

 

Slika 22. Efekt Black&White u LunaPic-u 
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Slijedeća opcija za konverziju kolor fotografije u crno-bijelu je Befunky. To je, 

također web stranica na koju je potrebno učitati fotografiju kako bi se mogla 

obraditi. Upload fotografije postiže se klikom na gumb prikazan na slici 22. 

 

 

Slika 23. Upload fotografije na Befunky, izvor: 

internetzanatlija.com/2015/04/22/kako-napraviti-crno-belu-sliku/ 

 

Nakon toga potrebno je odabrati opciju Effects, te odabrati selekciju 

Black&White prikazanu na slici 24. Zatim slijedi pohrana crno-bijele fotografije 

na računalo, i to uz naredbu Save. 
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Slika 24. Black&White efekt, izvor: internetzanatlija.com/2015/04/22/kako-

napraviti-crno-belu-sliku/ 

 

Picasa je program koji se potrebno instalirati na računalo. Prednost Picase je ta 

što se može povezati s Google računom i sadrži velikih broj različitih foto filtera. 

Ono što je dobro kod Picase je mogućnost da korisnik svoje slike može 

automatski učitati u svoj privatni Google + folder, i tamo ih čuvati. Jedan od 

efekata koji postoji u Picasi je i crno-bijeli efekt. Jedino što treba učiniti je otvoriti 

fotografiju i odabrati ga (Slika 25). Kako bi obrađena fotografija ostala 

sačuvana, potrebno je kliknuti Export (Izvoz) što je prikazano na slici 26. [14] 
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Slika 25. Crno-bijeli efekt u Picasi 

 

 

Slika 26. Spremanje fotografije u Picasi 
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3. EKSPERIMENTALNI DIO  

 

Eksperimentalni dio ovog rada sastoje se iz tri dijela. U prvom dijelu ispitivat će 

se vjernost crno-bijelih fotografija originalu nakon određenog postupka 

konverzije. Istraživanje će se provesti uz pomoć deset ispitanika koji će iznositi 

svoje subjektivno mišljenje. Ispitanici će morati poredati crno-bijele fotografije 

na temelju vjernosti originalu i to od najvjernije do najmanje vjerne. 

Drugi dio eksperimentalnog dijela rada temelji se na vlastitoj ekspertnoj analizi  

gdje će fotografije biti opisane na temelju tehničkih karakteristika (kontrast, 

svjetlina, ošrina, zasićenost i sl.) 

U trećem dijelu ovog poglavlja izrađivat će se histogrami za sve konvertirane 

fotografije koje su poredane po vjernosti originalu. Iz histograma će se očitavati 

zastupljenost svijetlih, srednjih i tamnih tonova na fotografiji da bi se na temelju 

toga mogli donijeti zaključci kako raspon tonova utječe na vjernost konvertirane 

fotografije originalu i na tehničke karakteristike kao što su kontrast, oštrina, 

svjetlina i slično.  

Na temelju ova tri načina ispitivanja, u konačnici će se izvesti zaključci kako 

konverzija općenito utječe na tonove crno-bijele fotografije. 

 

3.1. Autorske fotografije i njihove konverzije 

 

Za ekperimentalni dio rada snimljeno je pet fotografija različitih motiva koje su 

na osam različitih postupaka, koji su opisani u terijskom dijelu rada, 

konvertirane u crno-bijelu fotografiju. 
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Slika 27. „Neboderi u Dohi“, Lara Brenko (Canon EOS 500D, vrijeme 

eksponiranja: 1/250 s, otvor objektiva:11, osjetljivost: 100 ISO) 

 

a)     b) 

c)     d) 
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e)     f) 

g)    h)  

Slika 28. Konverzija fotografije „Neboderi u Dohi“: a) Black&White metoda;      

b) Grayscale metoda; c) Desaturation metoda; d) Channel Mixer metoda; e) Lab 

color metoda; f) Picassa; g) Befunky; h) LunaPic 
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Slika 29. „Leđa“, Lara Brenko (Canon EOS 500D, vrijeme eksponiranja: 13 s, 

otvor objektiva: 8, osjetljivost: 100 ISO)   

 

a)     b)   
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c)      d)  

e)     f)  
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g)    h)  

Slika 30. Konverzija fotografije „Leđa“: a) Black&White metoda; b) Grayscale 

metoda; c) Desaturation metoda; d) Channel Mixer metoda; e) Lab color 

metoda; f) Picassa; g) Befunky; h) LunaPic 

 

 

Slika 31. „Mrtva priroda“, Lara Brenko (Nikon D300, vrijeme eksponiranja: 10 s, 

otvor objektiva: 6.3, osjetljivost: 1600 ISO)   
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a)   b) 

c)    d) 

e)    f)  

g)   h)  

Slika 32. Konverzija fotografije „Mrtva priroda“: a) Black&White metoda; b) 

Grayscale metoda; c) Desaturation metoda; d) Channel Mixer metoda; e) Lab 

color metoda; f) Picassa; g) Befunky; h) LunaPic 
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Slika 33. „Portret“, Lara Brenko (Nikon D90, vrijeme eksponiranja: 100 s, otvor 

objektiva: 4.8, osjetljivost: 400 ISO)   

 

a)   b)  

c)   d)  
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e)   f)  

g)   h)  

Slika 34. Konverzija fotografije „Portret“: a) Black&White metoda; b) Grayscale 

metoda; c) Desaturation metoda; d) Channel Mixer metoda; e) Lab color 

metoda; f) Picassa; g) Befunky; h) LunaPic 

 

    

Slika 35. „Zelenilo“, Lara Brenko (Sony DSC-HX100V, vrijeme eksponiranja: 15 

s, otvor objektiva: 3.5, osjetljivost: 200 ISO)   
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 a)    b)  

c)     d)  

 

e)    f)  
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g)    h)  

Slika 36. Konverzija fotografije „Zelenilo“: a) Black&White metoda; b) Grayscale 

metoda; c) Desaturation metoda; d) Channel Mixer metoda; e) Lab color 

metoda; f) Picassa; g) Befunky; h) LunaPic 

 

 

Slika 37. „Oblaci i more“, Lara Brenko (Canon EOS 500D, vrijeme eksponiranja: 

2500 s, otvor objektiva: 3.5, osjetljivost: 100 ISO)   
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a)   b)

c)   d)

e)   f)

g)   h)  

Slika 38. Konverzija fotografije „Oblaci i more“: a) Black&White metoda; b) 

Grayscale metoda; c) Desaturation metoda; d) Channel Mixer metoda; e) Lab 

color metoda; f) Picassa; g) Befunky; h) LunaPic 
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4. REZULTATI I RASPRAVA 

 

4.1. Ispitivanje vjernosti crno-bijelih fotografija originalu 

 

U ovom dijelu istraživanja, kao što je već napomenuto, sudjeluje deset osoba 

koje iznose svoje subjektivno mišljenje o vjernosti crno-bijelih fotografija 

originalu. Zadatak ispitanika je poredati crno-bijele fotografije po vjernosti, i to 

od najvjernije do najmanje vjerne. Rezultati su prikazani u tablici 1. 

Tablica 1. Rezultati ispitivanja vjernosti crno-bijele fotografije originalu za slike 

27. i 28. 

Metode a) b) c) d) e) f) g) h) 

Osoba 1 3. 8. 6. 1. 7. 5. 4. 2. 

Osoba 2 3. 5. 7. 4. 8. 6. 1. 2. 

Osoba 3 7. 6. 2. 5. 3. 4. 8. 1. 

Osoba 4 3. 6. 7. 4. 8. 5. 1. 2. 

Osoba 5 4. 7. 3. 2. 6. 8. 1. 5. 

Osoba 6 3. 6. 7. 4. 8. 5. 2. 1. 

Osoba 7 5. 8. 6. 3. 4. 7. 1. 2. 

Osoba 8 2. 6. 8. 1. 7. 5. 4. 3. 

Osoba 9 3. 5. 7. 4. 8. 6. 1. 2. 

Osoba 10 4. 7. 8. 2. 3. 5. 1. 6. 

 

Prema prethodno odrađenom ispitivanju vjernosti crno-bijele fotografije, iz 

tablice 1, postupci konverzije fotografije prikazane na slici 27 mogu se prema 

vjernosti originalu poredati na sljedeći način: metoda konverzije uz pomoć  

Befunky online aplikacije, zatim slijedi konverzija pomoću LunaPic aplikacije, 

nakon toga Black&White metoda, iza nje Channel Mixer metoda, konverzija uz 

pomoć softvera Picassa, Grayscale metoda, Desaturation metoda te na 

posljednjem mjestu Lab color konverzija. 
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Tablica 2. Rezultati ispitivanja vjernosti crno-bijele fotografije originalu za slike 

29. i 30. 

Metode a) b) c) d) e) f) g) h) 

Osoba 1 1. 8. 4. 2. 7. 3. 6. 5. 

Osoba 2 3. 4. 1. 5. 8. 6. 2. 7. 

Osoba 3 2. 3. 7. 4. 8. 6. 1. 5. 

Osoba 4 4. 7. 2. 6. 8. 1. 5. 3. 

Osoba 5 1. 4. 7. 2. 8. 6. 5. 3. 

Osoba 6 1. 5. 6. 3. 4. 2. 7. 8. 

Osoba 7 1. 4. 7. 2. 8. 6. 5. 3. 

Osoba 8 5. 6. 8. 1. 7. 4. 3. 2. 

Osoba 9 7. 4. 5. 2. 8. 6. 1. 3. 

Osoba 10 1. 2. 7. 3. 8. 6. 5. 4. 

 

U tablici 2 vidljivo je da prema subjektivnom mišljenju ispitanika prvo mjesto 

zauzima crno-bijela fotografija dobivena konverzijom uz pomoć Black&White 

metode, a nakon toga slijede postupci: Channel Mixing, LunaPic, Grayscale, 

Befunky, Picassa, Desaturation metoda i, na kraju, Lab color. 
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Tablica 3. Rezultati ispitivanja vjernosti crno-bijele fotografije originalu za slike 

31. i 32. 

Metode a) b) c) d) e) f) g) h) 

Osoba 1 7. 2. 5. 6. 4. 3. 8. 1. 

Osoba 2 1. 4. 8. 5. 7. 3. 2. 6. 

Osoba 3 5. 3. 2. 7. 8. 1. 8. 4. 

Osoba 4 5. 2. 1. 7. 6. 3. 8. 4. 

Osoba 5 4. 1. 2. 3. 6. 5. 7. 8. 

Osoba 6 5. 6. 4. 7. 3. 1. 2. 8. 

Osoba 7 1. 7. 2. 3. 6. 5. 8. 4. 

Osoba 8 2. 1. 4. 5. 7. 3. 6. 8. 

Osoba 9 5. 3. 1. 7. 4. 2. 8. 4. 

Osoba 10 7. 1. 2. 8. 6. 3. 5. 4. 

 

Za tablicu 3, koja prikazuje vjernost crno-bijelih fotografija dobivenih iz 

fotografije prikazane na slici 31, karakteristično je da su postupci prema 

vjernosti poredani slijedećim redoslijedom: Grayscale metoda, Desaturation 

metoda, metoda konverzije u Picassi, metoda konverzije u LunaPicu, 

Black&White metoda, Lab color metoda, Channel Mixer metoda i, kao najmanje 

vjerna metoda, metoda konverzije uz pomoć Befunky aplikacije. 
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Tablica 4. Rezultati ispitivanja vjernosti crno-bijele fotografije originalu za slike 

33. i 34. 

Metode a) b) c) d) e) f) g) h) 

Osoba 1 2. 8. 7. 5. 4. 3. 6. 1. 

Osoba 2 2. 7. 8. 5. 6. 1. 3. 4. 

Osoba 3 8. 3. 5. 4. 7. 1. 6. 2. 

Osoba 4 5. 4. 3. 7. 8. 2. 6. 1. 

Osoba 5 1. 2. 5. 8. 6. 3. 7. 4. 

Osoba 6 2. 3. 4. 7. 8. 1. 6. 5. 

Osoba 7 3. 1. 5. 6. 4. 2. 8. 7. 

Osoba 8 2. 3. 5. 7. 8. 1. 6. 4. 

Osoba 9 1. 5. 7. 2. 8. 4. 6. 3. 

Osoba 10 2. 3. 5. 7. 6. 1. 8. 4. 

 

Prema tablici 4 postupci konverzije fotografije prikazane na slici 33 mogu se 

prema vjernosti originalu poredati na sljedeći način: metoda konverzije uz 

pomoć  Picasse, zatim slijedi Black&White metoda, nakon toga Grayscale 

metoda, iza nje metoda konverzije uz pomoć LunaPic aplikacije, Desaturation 

metoda, konverzija uz pomoć Befunky aplikacije, Channel mixing  metode te na 

posljednjem mjestu Lab color konverzija. 
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Tablica 5. Rezultati ispitivanja vjernosti crno-bijele fotografije originalu za slike 

35. i 36. 

Metode a) b) c) d) e) f) g) h) 

Osoba 1 1. 3. 6. 7. 8. 4. 2. 5. 

Osoba 2 6. 2. 4. 1. 8. 3. 5. 7. 

Osoba 3 7. 6. 3. 1. 8. 4. 2. 5. 

Osoba 4 8. 6. 3. 1. 7. 4. 2. 5. 

Osoba 5 7. 8. 1. 2. 6. 5. 3. 4. 

Osoba 6 7. 6. 2. 3. 8. 4. 1. 5. 

Osoba 7 8. 7. 3. 1. 5. 4. 2. 6. 

Osoba 8 7. 6. 2. 4. 3. 8. 1. 5. 

Osoba 9 6. 5. 3. 1. 8. 4. 2. 7. 

Osoba 10 7. 6. 3. 1. 8. 4. 2. 5. 

 

Prema rezultatima ispitivanja iz tablice 5 konvertirane se fotografije na osnovi 

primijenjenog postupka konvertiranja i vjernosti originalu, mogu poredati na 

slijedeći način: slika 36.d), slika 36.g), slika 36.c), slika 36.f), slika 36.h), slika 

36.b), slika 36.a) i , kao najmanje vjerna originalu slika 36.e) 
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Tablica 6. Rezultati ispitivanja vjernosti crno-bijele fotografije originalu za slike 

37. i 38. 

Metode a) b) c) d) e) f) g) h) 

Osoba 1 1. 7. 4. 6. 2. 3. 8. 5. 

Osoba 2 6. 2. 8. 4. 7. 5. 1. 3. 

Osoba 3 1. 3. 6. 2. 7. 5. 8. 4. 

Osoba 4 3. 5. 6. 2. 1. 7. 8. 4. 

Osoba 5 1. 3. 4. 2. 8. 5. 7. 6. 

Osoba 6 2. 3. 6. 1. 7. 5. 8. 4. 

Osoba 7 1. 4. 5. 2. 7. 3. 6. 8. 

Osoba 8 1. 3. 7. 2. 8. 5. 6. 4. 

Osoba 9 1. 8. 6. 3. 7. 4. 1. 2. 

Osoba 10 1. 3. 6. 4. 5. 2. 8. 4. 

 

Promatrajući rezultate iz tablice 6, može se reći da je, prema subjektivnom 

mišljenju ispitanika, prvo mjesto s obzirom na vjernost originalu, zauzela slika 

38.a), a iza slijede fotografije: slika 38.d), slika 38.b), slika 38.h), slika 38.f) slika 

38.c), slika 38.e) i posljednja slika 38.g). 

 

4.2. Vlastita analiza crno-bijelih fotografija 

 

Uspješna fotografija je ona koja privlači i zadržava pažnju i pogled promatrača 

te mu prenosi viđenja, osjećaje i razmišljanja fotografa. Ponekad dobra 

fotografija ne mora biti tehnički savršeno odrađena, ako je trenutak dobro 

uhvaćen. [18] 

U ovom radu snimljeno je šest kolor fotografija koje karakteriziraju različiti 

motivi, perspektive, kadrovi, svjetline i  rasponi tonova, te su, kao što je već 

navedeno, konvertirane u crno-bijelu fotografiju uz pomoć osam različitih opcija. 
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Prvi snimljeni motiv su neboderi u Dohi što je prikazano na slici 27. Promatrajući 

konvertirane fotografije, može se uočiti naglašenost dubine na fotografijama. 

Dubina je jače naglašena na fotografijama koje su srednje kontrastne,tj imaju 

normalan izgled, odnosno na fotografijama gdje je ljestvica tonova bogata, što 

je vidljivo na slikama 28.a), 28.c), 28.f), 28.g) i 28.h). Slike 28.b) i 28.d) su 

pretamne, te se na tim fotografijama gubi osjećaj dubine i snage zbog lošeg 

odnosa svjetla, sjena i linija. Slika 28.e) je presvijetla što znači da na njoj 

većinom prevladavaju jednolični sivi tonovi i to joj daje mekan izgled.  

Sljedeći fotografirani motiv su leđa (Slika 29) koja su, zapravo, implicirani akt. 

Ova fotografija snimljena je low key tehnikom za koju je karakteristična veća 

zastupljenost tamnih tonova, te buđenje osjećaja dramatičnosti i tajnovitosti. Pri 

fotografiranju se rasvjeta nalazi sa strane objekta i na taj način stvara sjene, 

dok interes privlače najsvjetlije točke, koje su, promatraju li se konvertirane 

crno-bijele fotografije, više ili manje naglašene. Fotografije na kojima, nakon 

postupka koverzije, najsvjetlije točke previše odvlače pažnju prikazane su na 

slikama 30.e) i 30.g). Jednolična, premalo kontrastna i sumorna fotografija, u 

ovom je slučaju, dobivena koverzijom uz Photoshop tehniku Grayscale (Slika 

30.b). Konvertirane fotografije na kojima je raspon tonova najprihvatljiviji, 

najbogatiji i najefektniji nalaze se na slikama 30.a), 30.c), 30.d), 30.f), 30.g) i 

30.h). Na tim su fotografijama optimalno naglašene linije uz pomoć sjena 

dobivenih zahvaljujući adekvatno postavljenoj rasvjeti, te je na taj način 

postignuta idealna optička ravnoteža. 

Fotografija „Mrtva priroda“ (Slika 31) u originalu (koloru) sadrži popriličan 

raspon različitih tonova i boja lišća, ali ti su tonovi i boje na konvertiranim 

fotografijama različito uočljivi. Linije su na svim fotografijama oštre i jasne, što 

znači da su granice među sivim, crnim i svijetlim tonovima jasno prikazane. 

Neke su fotografije previše kontrastne kao primjerice na Slikama 32.b), 32.e) i 

32.g), pa su na navedenim fotografijama, tonovi koji su na originalu svjetli, na 

konvertiranim fotografijama presvjetli, a tonovi koji su na kolor fotografiji tamni, 

na konvertiranim su fotografijama pretamni. Kod fotografije kovertirane 

Photoshop tehnikom Desaturation (Slika 32.c) može se vidjeti premali raspon 
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tonova i jednoličan izgled, dok su fotografije na Slikama 32.a), 32.d), 32.f) i 

32.h) optimalnog izgleda, bogate ljestvice tonova i optimalne optičke ravnoteže. 

Četvrti fotografirani motiv je muška osoba (portret) i prikazan je na slici 33. Kod 

ove fotografije karakteristično je to da je pravilnim rasporedom elemenata 

kompozicije i odabirom svjetla, naglašena važnost motiva, te fotografija zrači 

iskrenom emocijom. Nakon osam različitih postupaka konverzije, neke su 

konvertirane fotografije zadržale te karakteristike, a neke nisu (Slika 34). Glavna 

točka fotografije su oči, koje zadržavaju pogled, a to se svojstvo postiže 

odgovarajućom dubinskom oštrinom. [19] U ovom slučaju je na svim 

konvertiranim fotografijama zadržano svojstvo glavne točke interesa i dubinske 

oštrine, ali je se na nekim fotografijama gubi osjećaj prostora (Slika 34). Osjećaj 

prostora gubi se na fotografijama koje su previše kontrastne i tvrde, a to je 

ovdje slučaj na slikama 34.e) i 34.g). Slike 34.b), 34.c) i 34.d) su previše 

jednolične i ne ostavljaju nikakav dojam zbog previše sivila. Savršena 

naglašenost motiva i prostora, postignuta idealnim odnosom svjetlih i tamnih 

tonova, prikazana je na slikama 34.a), 34.f) i 34.h). 

Sljedeći fotografirani motiv je stabljika mente sa fokusom na listove koji se 

nalaze na vrhu stabljike (Slika 35). Konvertirane fotografije prikazane na slici 

36. karakterizira dosta prihvatljivi raspon tonova, dubinska oštrina, naglašenost 

motiva i svjetlina, osim fotografije konvertirane Lab color postupkom (Slika 

36.e), koja je presvjetla, premeka i jednolična. Fotografija 36.d) je malo tamnija i 

tvrđa, ali i dalje dovoljno bogata različitim rasponom tonova. 

Posljednji fotografirani motiv je oblačno nebo (Slika 37). Na kolor fotografiji 

može se vidjeti dubina mora, ritam valova, udaljenost brežuljka, voluminoznost 

oblaka, odnosno osjećaj velikog prostora. Prebacivanjem u crno bijelu varijantu, 

dobilo se na izražajnosti kontrasta i fotografija je postala dramatičnija, ali ni 

jedna tehnika konverzije nije oduzela kolor fotografiji prethodno navedene 

osjećaje (Slika 38). Jedino je fotografija kovertirana opcijom Grayscale tamnija 

pa daje osjećaj kao da je nebo oblačnije nego što jest (Slika 38.b). 
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4.3. Analiza histograma konvertiranih fotografija 

 

Histogram je grafički prikaz distribucije tonova. Kod crno-bijele fotografije 

histogram prikazuje informaciju o osvjetljenju tj. o rasponu sjena, srednjih 

tonova i svjetlih tonova (Slika 39.) Histogram crno-bijele fotografije definiran je 

tako da sadrži 256 „skupina“. U prvoj „skupini“ su potpuno crni, a u zadnjoj 

potpuno bijeli tonovi, a oni između imaju različite intezitete sive boje (od 

najtamnije do najsvjetlije), odnosnu u histogramu je svaki piksel opisan jednom 

nijansom sive bojom, gdje 0 znači crnu, a 255 bijelu. [20]  

 

Slika 39. Primjer histograma 

 

U ovom radu su histogrami izrađeni uz pomoć Photoshopa za svaku 

konvertiranu fotografiju, te su poredani na temelju rezultata dobivenih 

ispitivanjem desetero promatrača. Cilj je pokušati povući paralelu između 

histograma i rezultata ispitanika, te na temelju toga zaključiti na koji način utječe 

udio svijetlih, tamnih i srednjih tonova na promatrača, i na koji način različiti 

postupci konverzije kolor fotografije utječu na tonove crno bijele fotografije. 

 



 
56  

a)   b)  

c)   d)  

e)   f)  

g)   h)  

Slika 40. Histogrami konvertiranih fotografija poredani na temelju rezultata iz 

Tablice 1.: a) histogram konverzije uz pomoć  Befunky online aplikacije, b) 

histogram konverzije pomoću LunaPic aplikacije, c) histogram Black&White 

metode konverzije, d) histogram Channel Mixer metode konverzije, e) 

histogram konverzije uz pomoć softvera Picassa, f) histogram konverzije 
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Grayscale metodom, g) histogram konverzije Desaturation metodom, h) 

histogram konverzije uz Lab color metodu 

Iz histograma prikazanih na slici 40, koji se odnose na fotografiju „Neboderi u 

Dohi“, može se vidjeti da na konvertiranim fotografijama većinom prevladavaju 

srednji tonovi. Histogram prikazan na slici 40.a) sadrži nešto više svjetlih tonova 

te je, prema mišljenju ispitanika, kovertirana fotografija iz koje je dobiven taj 

histogram, okarakterizirana kao najvjernija. Isto tako, može se primjetiti da se 

histogram konvertirane fotografije, koji sadrži najveći udio sjene tj. tamnih 

tonova, nalazi na posljednjem mjestu. Prema mišljenju ispitanika, najbolja 

varijanta koverzije pokazala se Black&White opcija. 

 

a)   b)  

c)   d)  
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e)   f)  

g)  h)  

Slika 41. Histogrami konvertiranih fotografija poredani na temelju rezultata iz 

Tablice 2.: a) Black&White metoda konverzije, b) Channel Mixing metoda 

konverzije, c) LunaPic metoda konverzije,d) Grayscale metoda konverzije, e) 

Befunky metoda konverzije, f) Picassa metoda konverzije, g) Desaturation 

metoda konverzije, h) Lab color metoda konverzije 

Za histograme prikazane na slici 41 karakteristično je to da je većina tonova 

smještena na lijevoj strani, što je i logično jer je fotografija „Leđa“ nastala low 

key tehnikom fotografiranja gdje fotografiju čine sjene i tamni tonovi. Još se 

može primijetiti da kod ovih histograma nema nekog velikog kontrasta, a 

najmanje od svega ima svjetlih tonova. Vidljivo je da prva četiri mjesta, prema 

vjernosti originalu, zauzimaju gotovo identični histogrami. Dakle, prema 

rezultatima ispitanika, kao najvjernija konverzija pokazala se Black&White 

metoda, a kao najmanje vjerna originalu Lab color metoda kod koje se iz 

histograma može vidjeti da ima jednoličan izgled, tj. sadrži premalo kontrastnih 

tonova. 
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a)  b)  

c)  d)  

e)  f)  

 

g)  h)  

Slika 42. Histogrami konvertiranih fotografija poredani na temelju rezultata iz 

Tablice 3.: a) Grayscale metoda konverzije, b) Desaturation metoda konverzije, 

c) metoda konverzije u Picassi, d) metoda konverzije u LunaPicu, e) 
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Black&White metoda konverzije, f) Lab color metoda konverzije, g) Channel 

Mixer metoda, h) metoda konverzije uz pomoć Befunky aplikacije 

 

Kod histograma kovertiranih fotografija originala pod nazivom „Mrtva priroda“ 

vidljivo je da na fotografiji prevladavaju tamniji tonovi zbog tamne pozadine. 

Srednjih tonova ima jako malo, a svijetlih gotovo da i nema. Histogrami su svi 

gotovo identični, što znači da je raspon tonova na svim konvertiranim 

fotografijama gotovo jednak. Ovdje se kao najvjernija metoda konverzije 

pokazala Grayscale opcija, a kao najmanje vjerna metoda konverzije uz pomoć 

Befunky aplikacije. 

 

a)  b)  

c)  d)  

e)   f)  
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g)  h)  

Slika 43. Histogrami konvertiranih fotografija poredani na temelju rezultata iz 

Tablice 4.: a) metoda konverzije uz pomoć Picasse, b) Black&White metoda 

konverzije, c) Grayscale metoda konverzije, d) metoda konverzije uz pomoć 

LunaPic aplikacije, e) Desaturation metoda konverzije, f) konverzija uz pomoć 

Befunky aplikacije, g) Channel mixing metoda konverzije, h) Lab color   

konverzija 

Fotografija „Portret“  također je, kao i fotografija „Mrtva priroda“, snimljena na 

tamnoj pozadini. Iz tog se razloga na histogramima konvertiranih fotografija 

može vidjeti velika zastupljenost tonova na lijevoj strani, te gotovo nikakva u 

sredini i na desnoj strani. Ovdje je, prema vjernosti, na prvom mjestu metoda 

konverzije uz pomoć Picasse, a iz histograma se može vidjeti da najsvijetlijih 

tonova na fotografiji uopće nema. Na posljednjem mjestu je Lab color 

konverzija, iz čijeg histograma možemo pročitati najveću zastupljenost tamnih 

tonova. 

 

 

a)  b)  
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c)  d)  

e)   f)  

g)  h)  

Slika 44. Histogrami konvertiranih fotografija poredani na temelju rezultata iz 

Tablice 5.: a) Channel Mixer metoda konverzije, b) Befunky metoda konverzije, 

c) Desaturation metoda konverzije, d) Picassa metoda konverzije, e) LunaPic 

metoda konverzije, f) Grayscale metoda konverzije, g) Black&White metoda 

konverzije, h) Lab color metoda konverzije 

Za histograme dobivene iz konvertiranih fotografija originala „Zelenilo“ 

karakterističano je nešto malo tamnih i velik udio srednjih tonova, dok je udio 

svijetlih tonova jako mali. Ovdje se kao nabolja opcija, prema vjernosti originalu, 

pokazala Channel Mixer metoda konverzije, a kao najlošija Lab color metoda 

konverzije. Kod histograma fotografije dobivene Channel Mixer metodom može 

se uočiti veća zastupljenost tamnih, i manja zastupljenost svijetlih tonova nego 

kod Lab color metode. 
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a)  b)  

c)  d)  

e)   f)  

g)  h)  

Slika 45. Histogrami konvertiranih fotografija poredani na temelju rezultata iz 

Tablice 6.: a) Black&White metoda konverzije, b) Channel Mixer metoda 

konverzije, c) Grayscale metoda konverzije, d) LunaPic metoda konverzije, e) 

Picassa metoda konverzije, f) Desaturation metoda konverzije,g) Lab color 

metoda konverzije, h) Befunky metoda konverzije 
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Na slici 45 su prva dva histograma gotovo identična, dok treći, četvrti, peti i šesti 

pokazuju manja odstupanja. Histogrami koji imaju potpuno drugačiji izgled od 

ostalih su slika 45.g i 45.h. Od ostalih se razlikuju po tome što imaju puno manji 

raspon tonova općenito, sadrže manje kontrasta od ostalih histograma, što 

znači da su, konvertirane fotografije iz kojih su dobiveni ti histogrami, pomalo 

jednolične. 
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5. ZAKLJUČCI 

Opće je poznato da je crno-bijela fotografija, za razliku od kolor fotografije, 

oduvijek bila zanimljivija promatraču, te je duže zadržavala njegovu pažnju i 

zainteresiranost. Naravno da digitalna fotografija nikad neće uspjeti u 

potpunosti zauzeti mjesto klasične crno-bijele fotografije, iako se kompjuterskom 

obradom i korištenjem odgovarajućih kreativnih filtera i alata u obradi crno-bijele 

fotogafije, pokušava zamijeniti neki komplicirani i dugotrajni postupci klasičnih 

posebnih fotografskih tehnika. Neki efekti dobiveni klasičnim posebnim 

fotografskim tehnikama i dalje daju fotografiji veću vrijednost i značaj nego 

efekti dobiveni digitalnom obradom. U ovom radu nisu korištene nikakvi 

kreativni filteri, alati ni digitalne tehnike obrade ni kolor ni crno-bijelih fotografija, 

već samo različiti postupci konverzije originala (kolor fotografije) u crno-bijelu. Iz 

dobivenih rezultata može se zaključiti da različiti postupci konverzije različito 

utječu na tonove crno-bijele fotografije, ovisno o motivu, perspektivi, kadru i 

svjetlini. Tako se primjerice, za fotografiju arhitekture („Neboderi u Dohi“), kao 

najbolja opcija konverzije pokazala Befunky metoda, jer je (prema histogramu) 

zadržala najveći raspon tonova. Kod low key fotografije „Leđa“ najprihvatljivija 

konvertirana dobivena je Black&White metodom, gdje je, prema histogramu, 

raspon tonova najmanji, iz razloga što je smisao fotografije taj da je čine sjene i 

tamni tonovi, te je većina tonova zagasita i tamna, a svijetlih tonova ni nema. Za 

fotografiju „Mrtva priroda“, gdje, također, na originalu prevladavaju tamniji 

tonovi, najbolja metoda konverzije pokazala se Grayscale opcija i najmanji 

raspon tonova u histogramu. Fotografiju muškog portreta također karakreriziraju 

tamniji tonovi, crna pozadina i mali raspon tonova, a kao najbolja opcija 

konverzije, gdje se zadržao osjećaj prostora i naglaska na oči, pokazala se 

Picasa aplikacija. Iz dobivenih rezultata može se zaključiti da se kod fotografije 

„Zelenilo“ najbolji postupak konverzije Channel mixing metoda, a kod fotografije 

„Oblaci i more“ Black&White metoda. Važno je naglasiti da su prva fotografija i 

posljednje dvije fotografirane na dnevnom svjetlu, te su histogrami njihovih 

konvertiranih fotografija puno bogatiji tonovima, za razliku od preostale tri 

fotografije koje su nastale uz pomoć studijske rasvjete. Još se može zaključiti 

da konverzija itekako utječe na tonove crno-bijele fotografije, ali različiti ljudi 
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različito doživljavaju fotografije. Nekima se čine uvjerljivije svijetle, nekima 

tamne, a nekima sive. Dakako da su nekim ljudima vjernije originalu kontrastne 

fotografije, a drugima jednolične. Stoga je još bitno napomenutni, da, 

promatrajući fotografije s umjetničke i subjektivne strane, za savršenu 

konverziju nema pravila, jer ljudi percipiraju različito. Promatraju li se fotografije 

s tehničke strane, može se zaključiti da je najprihvatljivija opcija naknadna 

obrada fotografije nakon određenog postupka konverzije, kako bi se pravilno 

podesili kontrast, svjetlina, zasićenost tonovima i ostale bitne tehničke 

karakteristike. 
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